# Table of Contents

## Chapter 1 Introduction
  1. About Metatude 2
  2. About this manual 3

## Chapter 2 The Metatude Infrastructure
  1. Introduction 4
  2. Metatude components 5
  3. Additional components 7
  4. Unicode 9

## Chapter 3 Installation
  1. Installation 10
  2. Running the MDS 11

## Chapter 4 Setting up the MDS
  1. Configuring the MDS 12
  2. Preferences 16

## Chapter 5 Running as a Service
  1. Windows 17
  2. Linux 21

## Chapter 6 Usage
  1. Response Reports 22
  2. Console window 23
  3. Logfiles 25
  4. Multiple Sites 26
  5. E-mail Templates 27
  6. FAQ 28
  7. Unicode issues 31
  8. DB2 configuration 34
  9. PostgreSQL 35
  10. LDAP 36
  11. Memory 37

© 2001 - 2004 Metatude
1 Introduction

1.1 About Metatude

The Metatude software suite allows you to collect feedback on the performance and activities of your company from stakeholders such as customers, business partners, co-managers and employees. This information is vital to your company because it allows you to fine-tune your business activities and company policies to the perception of your performance. And it is this information that will allow you to gauge and influence what others say and think about your company, something that can make or break you. Essential information that constitutes the basis for your business decisions.

Metatude’s web-based software allows you to collect feedback on issues such as:

- customer satisfaction and loyalty;
- employee commitment;
- corporate reputation;
- business ethics;
- service level management.

Metatude is designed for large organizations whose IT infrastructure may be complex and have many stakeholders. Once the software is installed you can easily define target groups, create questionnaires, conduct research and manage output for analysis and reporting tools.

For more information on Metatude software, technology and business examples, please consult our website: http://www.metatude.com
1.2 About this manual

In this manual we show you how to install the Metatude Dialogue Server (MDS) step by step. After giving you some general information about the Metatude software suite, we will show you which preparations to make and how to install the application. After installation of the Metatude Dialogue Server the only thing that needs to be installed is a Metatude Channel Integration Component. After this your organization is ready to collect feedback from stakeholders via the Metatude software.

This manual is dated August 11th, 2004; Metatude will update this documentation if needed. Please check http://www.metatude.com/support/ for recent versions.
2 The Metatude Infrastructure

2.1 Introduction

The Metatude software suite consists of four different components:

- The Metatude Dialogue Server (MDS)
- The Metatude Project Manager (MPM)
- The Metatude Dialogue Designer (MDD)
- The Metatude Channel Integration Components (MCIC)

The basis of the Metatude architecture is a central server (Metatude Dialogue Server) that needs to be installed in your organization. This server maintains the connections with databases, stores and serves the dialogues to stakeholders and collects and stores the collected data in a database.

Once the Dialogue Server is installed, you can manage any stakeholder feedback with two desktop applications that are relevant for the regular user: the Metatude Dialogue Designer and the Metatude Project Manager. Consultants, managers and researchers can use these two applications to prepare questionnaires and manage projects involving stakeholder feedback.

In addition to these components, some additional infrastructure needs to be present in order to have a working setup of Metatude. The following figure shows the Metatude software components, and how they are integrated with the existing infrastructure.

![Diagram of the Metatude Infrastructure](image)

The components that you need to have installed in your network are:

- **SMTP Server**, this is used to send e-mail invitations to stakeholders.
- **Web Server**, for serving the dialogues to stakeholders.
- **An empty database**, for storing the results of your surveys.
- **A directory server or database** that contains stakeholder information.

These components can be installed on the same machine as the one that is used for the MDS, or can be anywhere on the network the MDS has access to (intranet and/or internet). Separate machines for these components will enhance the overall performance of the system. In the following chapters, these components are described in more detail.
2.2 Metatude components

The Metatude Dialogue Server (MDS)

The Metatude Dialogue Server is a Java application. Therefore it can run on any platform for which a Java Virtual Machine is available. However, thorough testing has been done on four platforms. We advise to use one of these operating systems for the MDS:
1. Windows NT 4 Server or Workstation with Servicepack 6a
2. Windows 2000 Server or Workstation with Servicepack 4
3. Windows 2003 Server
4. SuSe Linux 9.0 Personal or Professional edition

The Metatude Dialogue Server can run as a service on any of these platforms.

Communication with other Metatude components is done using the SOAP protocol. Each message that is exchanged is in XML format. SOAP is a protocol that is created to be used over any HTTP connection. SOAP messages look a lot like ordinary HTML messages. The XML messages that are exchanged between the different Metatude components are encapsulated in a SOAP message. Because any HTTP connection can be used to exchange messages, including HTTP Proxy servers, the Metatude Dialogue Server can usually be deployed quite easily in any office intranet or other network.

The Metatude Dialogue Server listens on port 6382. The Metatude Project Manager and the Metatude Channel Integration Components connect to the Metatude Dialogue Server on this port. The Metatude Dialogue Server itself does not initiate any connection to other Metatude components. The port number 6382 is the default port number. It can be changed after the Metatude Dialogue Server is installed.

The Metatude Dialogue Server connects to an SMTP server for sending out e-mails. It sends out e-mails just as any normal e-mail client would do. You can configure the hostname and port of the SMTP server.

An empty database is used for storing results of survey projects. The Metatude Dialogue Server connects to a database using TCP/IP. You can configure the hostname and port for this database.

In order to retrieve stakeholder information, the Metatude Dialogue Server connects to a stakeholder directory over TCP/IP using the LDAP protocol. Stakeholder information can also be retrieved from any database.

The Metatude Channel Integration Components (MCIC)

The Metatude Channel Integration Components are web applications that need to be installed on your webservers. The Metatude Channel Integration Components serve the dialogues to stakeholders through HTTP. The dialogues can be viewed with any browser, such as Internet Explorer, Opera or Mozilla Firefox. After a stakeholder has received an invitation through e-mail, they request a dialogue by clicking on an URL.

Your webservers receive this HTTP request. It starts the MCIC web application. Then, the MCIC makes a network connection with the MDS. The MDS looks up the stakeholders information and sends the correct dialogue to the MCIC. The MCIC then serves the dialogue in HTML format to the stakeholder.

You can read how to install an MCIC in the MCIC Installation Manual.
The Metatude Project Manager (MPM)

The Metatude Project Manager is used to create new survey projects on the Metatude Dialogue Server. A project consists of a dialogue, a target group, an invitation and possible reminder e-mails and the results of a survey.

A target group is a selection of stakeholders. These stakeholders are present in your stakeholder database or directory server. With the Metatude Project Manager, you can select a group of stakeholders by setting certain criteria. Such a group is called a target group.

To each stakeholder in the target group an invitation e-mail is sent. In this e-mail, you invite the stakeholder to participate in your survey project. You can personalize this e-mail in various manners. The invitation e-mail contains an URL to the dialogue. When a stakeholder clicks this URL, a browser window is opened and the dialogue is presented.

You can schedule different reminder e-mails for each project. If a respondent has not filled out a dialogue, a reminder can be sent automatically.

After stakeholders have filled out a dialogue, you can download the results using the MPM. These can be downloaded as an Excel sheet, as an SPSS (Statistical) file or as a plain text file.

When you start the MPM, you need to login to the MDS. You need to provide the hostname of the MDS, and a port number, if the MDS does not run on the default port. You also need to enter your username and password. It is possible to use a proxy server for connecting to the MDS. This can be any ordinary HTTP proxy server that is located between the MPM and the MDS. You can enter the hostname and the port number of the proxy server on the login screen of the MPM.

The Metatude Dialogue Designer (MDD)

With the Metatude Dialogue Designer, you create dialogues. These consist of an introduction, a list of questions and an epilogue. It is possible to create interactive dialogues. This means that stakeholders can be asked different questions, based on their input from previous questions.

A dialogue is saved as an XML file. This file is uploaded to the MDS when you create a project using the MPM.
2.3 Additional components

In this chapter, the additional components that need to be available for a Metatude installation are explained.

An SMTP Server

The MDS sends out e-mails to stakeholders. It does this by connecting to your SMTP server, just as any normal e-mail client does. You can use any SMTP server for this purpose.

A Web Server

The webserver is used to serve the dialogues to stakeholders. On the webserver, a web application, called the Metatude Channel Integration Component (MCIC) must be installed. Components are available for:

- Microsoft IIS server 4, 5 and 6
- Apache Tomcat 4.1 or any other Java Servlet Container

The MCIC connects to the MDS using SOAP. On the MCIC, you can configure the hostname and the port number of the MDS. The default port for the MDS is 6832. Please see the Metatude Channel Integration Components Installation Manual for more details.

A Database

The MDS stores the results of the surveys in a database. Any of the following databases can be used:

- Oracle 8i, Oracle 9i
- Microsoft SQL Server 2000
- IBM DB2 version 8.1
- PostgreSQL 7.3

The MDS connects to any of these databases using TCP/IP. Before you install the MDS, you need to create an empty database and a database user that can be used by the MDS for storing and retrieving results. You can also use a database user that is already available.

Please use any of the following character encodings in the empty database:

- UTF-8
- UCS-2
- ISO-8859-1

If the database you have created uses UTF-8 as encoding, Unicode support will be enabled throughout the Metatude installation. If you use ISO-8859-1 as the encoding for your database, Unicode support will not be available. When you use a SQL Server database, automatically, UCS-2 encoding is selected and Unicode support is available.

After the MDS is configured, it creates a set of tables in the empty database. The MDS uses these for storing settings and other information. Each time a project or directory server is created, new tables are created in the database.
A Directory server

The stakeholder information is retrieved from a directory server or from a database. After you have installed the MDS, you can configure these with the MPM. Additional manuals on the Metatude CD-ROM describe how to connect to various directory servers. You can use any of the following sources to retrieve stakeholder information:

- Microsoft Exchange 5.5
- Microsoft Active Directory
- Lotus Notes Domino Server
- Netscape Directory Server
- Novell eDirectory
- Any LDAP server
- Any database

The MDS connects to these sources using TCP/IP. For any of the above mentioned sources, except the database, the LDAP protocol is used. You can use multiple directory servers at the same time.
2.4 Unicode

Unicode is a system that was developed to support internationalization in applications. The Metatude software can make use of Unicode. With Unicode, it is possible to get stakeholder feedback in any language. All European and non-European characters are supported in the Unicode standard.

The databases and directory servers that provide stakeholder information may be using the Unicode standard. Also, the dialogues and results can make use of Unicode.

Unicode support in the Metatude software is automatically enabled or disabled, based on the format of your results database. If this database uses a supported Unicode encoding (UTF-8 or UCS-2) then Unicode will be available. If your results database uses the Western European encoding (ISO-8859-1) then Unicode support is disabled. When you use a Microsoft SQL Server database for storing results, Unicode is automatically enabled.

The dialogues that are created by the Metatude Dialogue Designer (MDD) can be saved in two encodings: ISO-8859-1 and UTF-8. If Unicode support is enabled, you can use the UTF-8 encoding to save dialogues. If Unicode support is not enabled, you must save your dialogues using the ISO-8859-1 encoding.
3 Installation

3.1 Installation

The installation procedure for a Linux system is the same as for a Windows system. The initial installation of the MDS is as follows:

For Windows OS:
- Insert the Server software CDROM
- Start the MDS installer from `<CD_DRIVE>\Dialogue_Server_for_Windows\setup.exe`
- The installation process is now started
- In order to install you need to answer some questions. You need to accept the terms of the license agreement and indicate the directory where you would like to install the Metatude Dialogue Server. After these questions you can press the button 'install', after which installation takes place
- After completion of the installation process press the button 'done'

The Metatude Dialogue Server is now installed.

For Linux/Unix OS:
- Login as the root user
- Insert the Server software CDROM and mount it.
- Start the MDS installer from `<CD_DRIVE>/Dialogue_Server_for_Linux/install.bin`
- The installation process is now started
- In order to install you need to answer some questions. You need to accept the terms of the license agreement and indicate the directory where you would like to install the Metatude Dialogue Server. After these questions you can press the button 'install', after which installation takes place
- After completion of the installation process press the button 'done'

The Metatude Dialogue Server is now installed.
3.2 Running the MDS

You can start the MDS in the following manner (the first time you start the MDS, you need to enter several configuration settings, see next topic):

**Windows:**
After installation, you can start the MDS. The following steps are required to start MDS.

For Windows XP:
1. Click **Start > All Programs > Metatude > Metatude Dialogue Server > Metatude Dialogue Server**
2. The first time you do this, the application asks you some questions. Make sure you have made the right preparations to answer these questions.

For Windows 2000/98/95
1. Click **Start > Programs > Metatude > Metatude Dialogue Server > Metatude Dialogue Server**
2. The first time you do this, the application asks you some questions. Make sure you have made the right preparations to answer these questions.

**Linux:**
After installation, you can start the MDS. The following steps are required to start MDS.

1. Login as the root user, open a terminal window
2. Go to the directory where the MDS is installed (the default is `/opt/mds`)
3. Start the MDS by typing: `./mds`
4. The first time you do this, the application asks you some questions. Make sure you have made the right preparations to answer these questions.

**Running the Linux version of the MDS with a normal user:**
Only directly after the installation you need to run the MDS with the root user. After you have successfully entered all the preferences (see next chapter) you can run the MDS under any normal user. The MDS needs write access to its logfiles and to the preference files. The logfiles are located in the directory `/var/log/mds` and the preference files are located at `/opt/mds/preferences.dat` and `/opt/mds/mds.lax`. To set the proper rights on these files, enter these commands in a console window:

```
chown youruser.yourgroup /var/log/mds
chown youruser.yourgroup /var/log/mds/*
chown youruser.yourgroup /opt/mds/preferences.dat
chown youruser.yourgroup /opt/mds/mds.lax
```

Here, `youruser` is the username you want to use and `yourgroup` the default group for that user (or any other group you wish to use). You can then start the MDS under the user `youruser`. You can create a new user in Linux by using the command `adduser`. Set the home directory of your newly created user to the installation directory of the MDS (default: `/opt/mds`).

The script that starts the MDS as a service assumes that you run the MDS with the root user. Please modify this script to run the MDS with your newly created user. See the chapter ‘Running as a Service’ for more details.
4 Setting up the MDS

4.1 Configuring the MDS

When you start the MDS for the first time it asks the following questions:

**Do you want to continue?**
To continue type 'y' and press 'enter'

**A. Which database product do you use?**

[1] Oracle
[2] PostgreSQL
[3] MS SQL Server
[4] DB2
Type the appropriate number and press 'enter'

**B. What is the JDBC connection url to use?**

This is the JDBC (Java Database Connectivity) connection to your database and has different formats for different databases.

**Oracle database:**
The format for the URL is as follows:

```
jdbc:oracle:thin:@<hostname>:<port>:<database name>
```

The hostname can also be an IP address. If you called the database ResultsDB and it is running on port 1521 (the default Oracle port) on a machine with IP address 192.168.84.16, the url is:

```
jdbc:oracle:thin:@192.168.84.16:1521:ResultsDB
```

**Postgresql database:**
The format for the URL is as follows:

```
jdbc:postgresql://<hostname>:<port>/<database name>
```

The hostname can also be an IP address. The port number only has to be given when it is another value than the default value, which is 5432. So if you called the database ResultsDB and it is running on a machine with IP address 192.168.84.16, the url is

```
jdbc:postgresql://192.168.84.16:5432/ResultsDB
```

**Microsoft SQL Server database:**
The format for the URL is as follows:

```
jdbc:microsoft:sqlserver://<hostname>:<Port>;databaseName=<database name>;selectMethod=cursor
```

The hostname can also be an IP address. The default port number for Microsoft SQL Server is 1433. So if you called the database ResultsDB and it is running on a machine with IP address 192.168.84.16, the url is

```
jdbc:microsoft:sqlserver://192.168.84.16:1433;databaseName=ResultsDB;selectMethod=cursor
```

Please note that you cannot use Windows authentication to connect to an SQL Server database. You need to access any SQL Server database using SQL Server authentication. If your SQL Server is not installed to use SQL Server authentication, then you can try to use ODBC to connect to this database (see below).
**IBM DB2 database:**
The format for the URL is as follows:

```
jdbc:db2://<hostname>:<port>/<database name>
```

The hostname can also be an IP address. The default port number for IBM DB2 is 50000. So if you called the database ResultsDB and it is running on a machine with IP address 192.168.84.16, the url is `jdbc:db2://192.168.84.16:50000/ResultsDB`

C. **What is the username to logon to the database?**
If the MDS needs a username and password to connect to the database, here you can fill out the username. If no username is needed, you can leave this space blank and just press enter.

D. **What is the password to logon to the database?**
If the MDS needs a username and password to connect to the database, here you can fill out the password. If no password is needed, you can leave this space blank and just press enter. The password that you enter will be echoed in readable text while you type it. Make sure nobody is 'watching over your shoulder' when you enter the password.

E. **You can change the driver name if needed. Or accept the default JDBC driver for the database you selected.**
The MDS automatically selects the database driver that is to be used to connect to the database. Generally, you can leave this value unchanged. The MDS uses proprietary drivers for Oracle, PostgreSQL, MS SQL Server and IBM DB2 databases. These drivers are incorporated in the software. Type 'y' to accept the default driver. If you want to use another driver, you can type 'n', after which you will be given an opportunity to type the name of the driver you wish to use. Please bear in mind that the name of the database driver is case-sensitive, and that the driver files need to be in your CLASS_PATH.

*Please note:* The same JDBC URL's and drivers can be used to connect to a stakeholder database from the Metatude Project Manager.

F. **What is the SMTP adress?**
Here you can enter the adress of the SMTP server that is to be used by the MDS for sending out email. This can be either a hostname or an IP adress.

G. **You can change the port to use for the SMTP connection. Or accept the default port for the SMTP connection.**
The MDS needs to know the port on which the SMTP server runs. For SMTP servers this nearly always is the value 25. If this is the case, accept the default value by typing 'y'. When the SMTP server runs on a different port, type 'n' for no and you will be given an opportunity to enter the value of the SMTP port.

H. **Please enter a name for your site**
Please enter the name that you wish to give your Stakeholder feedback site. You can enter any name here. This name will show up in the Metatude Project Manager, when creating a new project. A good name to choose is the name of your company. For more information, see the chapter 'Multiple Sites'.
I. Please enter the MCIC URL for this site
The MDS needs to know on which webserver the Metatude Channel Integration Component runs. This information is used to send out emails with the right URL to launch a dialogue. In case you use IIS to serve the dialogues, the format of the adress is:

http://webservername/directory/default.asp

So if the MCIC will run on your internet server called 'www.mycompany.com' in the directory 'metatude', you need to enter http://www.mycompany.com/metatude/default.asp

In case you are using the Apache/Tomcat combination, the URL has the form:

http://webservername/directory/Get

The default directory that is used when installing the MCIC for IIS or Apache/Tomcat is 'metatude'. An example of an URL is http://www.mycompany.com/metatude/Get

If you are using Tomcat without Apache, then you also need to enter the port Tomcat is running on in the URL. The default port for a standalone Tomcat installation is 8080.

J. Do you wish to specify an e-mail template for this site?  
[optional]
If you have an e-mail template ready, and have placed in the Stationery subdirectory, then you can enter its name. Choose 'y' to enter the name of the template. The MDS checks if the template exists and has the correct format. If you do not have an e-mail template ready, choose 'n'. You can specify an e-mail template later. For more information, see the chapter 'E-mail templates'.

K. Please enter the Client's Name (For whom the License Key is registered)
In order for the MDS to function, you need to enter the client name that is given to you. This name is matched against the name that is encrypted in the license key. If they are not exactly the same, the MDS will not start. This name is case sensitive.

L. Please enter the License Key
In order for the MDS to function you need to enter the license key that is given to you. This Key will unlock a number of users, stakeholders and a period of time that the MDS will run. After you enter the correct license key, the MDS will check the key. If the key is valid, the console will display the number of users and the number of stakeholders that are unlocked and will show the date until which the MDS will run with this license key. The license key is case-sensitive.

M. Please enter the Administrator's password
Here you can enter the password for username 'Administrator'. You can use this password to log on to the MDS using the Metatude Project Manager. Please note that the username and the password are case-sensitive. The password that you enter will be echoed in readable text while you type it. Make sure nobody is 'watching over your shoulder' when you enter the password.

N. You can set MDS to send Response Report Status (RRS) to Metatude and/or MDS administrator (own email address). Which one you like?
   [1]Send only to Metatude.
   [2]Send only to MDS administrator (own email address).
   [3]Send to both Metatude and MDS administrator (own email address).

You can choose if you want the monthly response reports to be e-mailed to you and/or to Metatude. When you choose to have the response reports e-mailed to you, you will be asked to enter your e-mail address.
After you have answered these questions, the MDS has all the information to operate. The console will display the following message:

Main Database Product Name and Version : PostgreSQL 7.3.4
JDBC Driver Name and Version           : PostgreSQL Native Driver
PostgreSQL 7.3.4 JDBC3 jdbc driver
MDS Database Encoding/Character set     : UNICODE

Product ID: 1
Product version: 1
Client ID: 1
Client Name: Metatude
Total users: 9999
Total LDAP connections: Unlimited
Total JDBC connections: Unlimited
Total stakeholders: Unlimited
Total monthly responses: 999999999
Database Feedback Option: true
This Server will run until: Jan 1, 2010 12:00 AM

-----------------------------------------------------------------
Metatude Dialogue Server running on port  6382
This is MDS R2.2 Final
-----------------------------------------------------------------

You can verify the database connection info, such as the encoding. Also, your license options are shown.

You can stop the MDS by typing the command exit in the console window. For more commands, please see the chapter 'Console window'.
### 4.2 Preferences

When installing the Metatude Dialogue Server, in the database where the results are stored a table is created which holds the preferences of the MDS. This table is called `Preferences`. The records in this table can be edited to other values. If the MDS is restarted, the new values will be used. Most values can be set in the command interface of the Metatude Dialogue Server. Only edit the preference table by hand if you have to.

<table>
<thead>
<tr>
<th>Name</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serverport</td>
<td>6382</td>
<td>Port of the Metatude Dialogue Server</td>
</tr>
<tr>
<td>MaxUserSession</td>
<td>900000</td>
<td>Time (in milliseconds) which time an idle user session is aborted</td>
</tr>
<tr>
<td>MaxLockTime</td>
<td>600000</td>
<td>Maximum time (in milliseconds) any table can be locked. After this time the lock is removed</td>
</tr>
<tr>
<td>smtpHost</td>
<td></td>
<td>The adress of the SMTP server that is used to sent out emails</td>
</tr>
<tr>
<td>smtpPort</td>
<td>25</td>
<td>Port of the SMTP server</td>
</tr>
<tr>
<td>McicUrl</td>
<td></td>
<td>The url of the webserver used</td>
</tr>
<tr>
<td>ProjectMonitorSession</td>
<td>540000</td>
<td>This monitor checks the project status and starts projects on time. Default interval to wakeup : 540000 ms (milliseconds)</td>
</tr>
<tr>
<td>InvitationMonitorSession</td>
<td>600000</td>
<td>Manages invitations. Makes sure that emails are sent out at the start of a project and invites extra people when response is low.</td>
</tr>
<tr>
<td>DirServerMonitorSession</td>
<td>10800000</td>
<td>MDS runs this monitor to connect to the directory server to get the current size of the directory server and update it in MDS database.</td>
</tr>
<tr>
<td>SessionMonitorSession</td>
<td>120000</td>
<td>Session monitor keeps track of valid session. Each client has 15 minutes valid session (Time depends on preferences setting). If the client does not talk to the server for 15 minutes the session monitor collects this session id and delete it, forcing the client to re-login.</td>
</tr>
<tr>
<td>InvitationInterval</td>
<td>345600000</td>
<td>Time between two invitation sessions for a specific project. Default value is 4 days. If after this period the response is too low, new invitations are sent out.</td>
</tr>
<tr>
<td>rrsstatus</td>
<td>1</td>
<td>Sets response report feature on and off</td>
</tr>
<tr>
<td>rrsuseremail</td>
<td></td>
<td>the e-mail address to which response reports are sent</td>
</tr>
<tr>
<td>max ldapsize</td>
<td>5500</td>
<td>maximum number of stakeholders that can be connected through LDAP</td>
</tr>
<tr>
<td>dfoactivationinterval</td>
<td>14400000</td>
<td>milliseconds between retries of a database feedback template</td>
</tr>
<tr>
<td>dfoactivationlimit</td>
<td>6</td>
<td>number of times a database feedback template should be retried</td>
</tr>
<tr>
<td>dfodeleteinterval</td>
<td>864000000</td>
<td>time in milliseconds after which failed database feedback templates are deleted from the server</td>
</tr>
</tbody>
</table>
5 Running as a Service

5.1 Windows

Overview
The MDS is capable to run as a Windows service. The MDS server can be run either as a background service (hidden) or the MDS can be run with its console window. Using Services, you can start or stop services on remote and local computers, and configure startup options.

Setup
- Install the MDS by running the MDS installer.
- To configure service startup, you must be logged on as a Windows administrator or as a member of the Administrators group.
- If you want to run Metatude Dialogue Server as a service, you must have run the server with its console window at least once to pass its initialization parameters. This can be done by starting the MDS from the Windows Start menu or from the Service panel with the console window enabled.

How to start Metatude Dialogue Server as a service
- Click Start > Programs > Metatude > Metatude Dialogue Server > Start MDS as a Service. The Metatude Dialogue Server will be started with the console window enabled.

How to stop Metatude Dialogue Server service
- Click Start > Programs > Metatude > Metatude Dialogue Server > Stop MDS as a Service. The Metatude Dialogue Server service will be stopped.

Change Service settings
- After installation, open Services. To open Services, click Start, point to Settings, and then click Control Panel. Double-click Administrative Tools, and then double-click Services. Look for the service name Metatude Dialogue Server.

![Figure 1. Windows services](Image)

- Right-click the service name Metatude Dialogue Server, and then click Properties.
On the **General** tab, under **Startup**, you can set the startup type to **Automatic**, **Manual**, or **Disabled**. The default is **Manual**. Set this to **Automatic** if you want the Metatude Dialogue Server to start when the system is booted.

- Click the **Log On** tab, and then click **System account**. To disable the Metatude Dialogue Server console window on the desktop that can be used by anyone who is logged on when the service is started, deselect the **Allow service to interact with desktop** check box.
Go back to General tab and click the Start button to start the service with the console window.


Metatude Dialogue Server as a background (hidden) service
If Metatude Dialogue Server runs as a background service, users will not be able to see the server console window. To run the server as a background service, uncheck the Allow service to interact with desktop at the Log On tab of the Service properties (figure 3). And start/restart the service.

Installation defaults for Metatude Dialogue Server as Windows service
Service Name: Metatude Dialogue Server
Display Name: Metatude Dialogue Server
Path to executables: <User_Installation_path_of_MDS>\service\srvany.exe
Startup type: Manual
Service status: Stopped
Allow service to interact with desktop: Yes

How to uninstall/remove service after uninstalling Metatude Dialogue Server
Stop the Metatude Dialogue Server service before you attempt to uninstall it. Otherwise the uninstallation process will fail to remove a few files. After uninstalling Metatude Dialogue Server, to remove the service entries from the service panel, run the RemoveNTService.bat located at <Metatude Dialogue Server Installation Directory>\service.
Difficulty with database connections
The Metatude Dialogue Server may fail to connect to a database that uses windows ODBC if started as a service. If the server is started manually from the Start menu, there will be no ODBC errors.

If the Metatude Dialogue Server fails to connect to the database while creating a Directory Server, the Metatude Project Manager will show the following error:

Unable to connect to directory server.

Reason and solution:
The main reason for this connection problem is related to User rights. The user must be logged on as an administrator or as a member of the Administrators group. If the database is running from a machine other than the MDS machine and the database machine is under a domain, the MDS machine user must have proper access to that domain. The user should log on as a domain user for the above configuration. This can be configured in the services properties, as shown above. If an ODBC database is on the same computer as the MDS, try using a System DSN for creating an ODBC Datasource.

Some services rely on other services to start. Metatude Dialogue Server service may start before other services depending upon your system. Other service will be unavailable to the MDS if they start after the MDS starts. This problem may cause a database service or ODBC related database to be unavailable to the MDS. Stop and start the Metatude Dialogue Server service again to overcome this situation.
5.2 Linux

Overview
The MDS is capable to run as a Linux service. This means that the MDS can automatically be started at system boot time and can automatically be stopped at system shutdown. The output of the MDS can be directed to a log file or can be disabled. When the MDS is started as a service, no user interaction can take place through a console window.

Enabling the MDS service
In order to successfully run the MDS as a service, the output that is normally directed to the MDS console window should be directed to a file or should be disabled. Also, the input for the MDS must be disabled. To do this, edit the mds.lax config file. It is located at /opt/mds/mds.lax for a default installation. Set the following variables to the correct values:

lax.stderr.redirect=/var/log/mds/stderr.txt
lax.stdin.redirect=
lax.stdout.redirect=/var/log/mds/stdout.txt

With the above settings, the output will be directed to log files. To disable the output, set the variables to the following values:

lax.stderr.redirect=
lax.stdin.redirect=
lax.stdout.redirect=

On a RedHat or SuSE System, run the following command to enable the MDS service:
/sbin/chkconfig --add mds

On a SuSE system, you need to configure the startup of the MDS so that it takes place after your database has started. Also, upon shutdown, the MDS needs to be stopped before your database stops. To do this, change the symlinks in /etc/init.d/rc3.d and in /etc/init.d/rc5.d to a higher start number and a lower stop number. To do this, change into these two directories and type:
mv S01mds S16mds
mv K20mds K05mds

On a Debian system, run the following command to enable the MDS service:
/usr/sbin/update-rc.d mds defaults 95 07

This will enable the MDS service to start at system boot and to stop at system reboot/shutdown.

Change service settings
The MDS service assumes you installed the MDS with default values. To change the directory where the MDS is installed, or to change the user under which the MDS runs, enter the correct values in the file /etc/init.d/mds.

Manually Starting the MDS as a service
Run the following command to start the MDS as a service:

/etc/init.d/mds start

The MDS will be started as a service. It will run as a background process and it will continue to run, even after you log out.

Manually Stop the MDS as a service
Run the following command to stop the MDS service:

/etc/init.d/mds stop

The MDS service will be stopped.
6 Usage

6.1 Response Reports

The Metatude Dialogue Server can send out a monthly email report. This report contains information about the projects that were active in the last month. The reports will be sent to an email address at Metatude (response@metatude.com). You can choose to send the report also to another email address.

This feature is developed since for some agreements the usage (partly) determines the license fees to be paid to Metatude. In that case, Metatude needs this information. Also, this information can be helpful in identifying problems, but you can also use it yourself, for example when billing (internal) clients yourself.

Attention:
- Only information on the usage is sent. No other information, such as results or specifics about people who responded.
- If you don't want this information to be sent to Metatude, just say no to the option of response reports when installing the MDS. Metatude only wants this information when both parties agreed upon sending it beforehand.

For each project, the following information is specified in the report:

- **Project ID**: The ID of the project
- **Project name**: The name of the project
- **Number invited**: The number of respondents that were invited
- **Number submitted**: The number of responses that were submitted.
- **Start date**: The start date of the project.

When you want the reports to be e-mailed to Metatude, then please make sure that the SMTP server that you are using is connected to the internet.

When the Metatude Dialogue Server is configured after the initial installation, you can indicate whether you want to have the Response Reports e-mailed to you or Metatude or not. You can change the settings from the console window of the MDS.
6.2 Console window

When you press ?, info, help or menu in the console window of the MDS, you will see the following help screen:

-----------------------------------------------------------------------
MDS R2.2 Final
------------------------------------MENU-------------------------------
exit                    Stops Metatude Dialogue Server.
exit -now               Forced stop Metatude Dialogue Server.
ldap                    Prints current maximum size of LDAP stakeholder.
ldapc                   Changes maximum stakeholder size for LDAP.
lk                      Prints License information.
lkc                     Change License Key.
lm                      Writes Log Monitor Status [monitor status will be
stored in event log file].
mail -project_id        Prints number of mails sent for this project.
mdsport                 Prints current MDS port no.
mdsportc                Changes MDS port.
urll                    Lists all sites registered to this MDS.
urla                    Adds/registers a site to this MDS.
urle                    Edits a site registered to this MDS.
urld                    Deletes a site registered to this MDS.
quit                    Forced stop Metatude Dialogue Server.
smtp                    Prints current SMTP settings.
smtpc                   Changes SMTP settings.
dfoapc                  Changes the MDS's DFO (Database Feedback
Operation) monitor activation period.
dfoalc                  Changes the MDS's DFO (Database Feedback
Operation) monitor activation limit.
dfoddac                 Changes the MDS's DFO (Database Feedback
Operation) Delete data after value.
tem                     Toggles Error Mode [Error(s) will (not) be
printed].
tmm                     Toggles Mail Mode [mailing status will (not) be
printed].
vm                      Prints Virtual Machine size.
vmc                     Changes Virtual Machine size.
ver                     Prints the MDS version.
rrs                     Prints current status of RRS feature.
rrsc                    Changes the status of RRS feature.
attachsize              Prints maximum attachment size supported by MDS.
attachsizec             Changes the maximum attachment size supported by
MDS.
createmdsinfo           Creates a text file containing MDS information.
-----------------------------------------------------------------------

Enter one of the above commands to perform the desired action.
Usage

Extra information:
LDAP: Prints the maximum number of LDAP stakeholders that can be fetched by the MDS.
LDAPC: To enter a new stakeholder size for LDAP. The default size is 5500. This size can be increased with this command. Please note that the increase of the LDAP stakeholder size may also consume more memory. If you want to connect more than 50000 stakeholders, enter -1 as new size. This will result in an unlimited number of stakeholders that can be connected.
LM: [Log Monitor Status] All 'start' and 'end' information of each monitor will be stored in the event log when LMS is on.
Mail -[project id]: Replace [project id] by the actual project ID. This command will show the total number of e-mails sent in that project.
DFOAPC: Specify time between retries of failed executions of a database feedback template (in hours)
DFOALC: Specify how many times a retry should be attempted for a failed execution of a database feedback template
DFODDAC: Specify how long failed database feedback templates are kept on the server (in days)
TDM: TDM is used to toggle debugOn function. If the debugOn value is true in the MDS preference file, then TDM in the console will make it false internally, but will not write it to the file preference file. MDS stops showing details. Typing TDM again on the console will make MDS debug mode true.
TMM: [Toggle Mail Mode] If the debugOn is true, MDS shows lots of information which may not be useful for a specific purpose. If just mail sending information is needed, TMM may be used. If TDM is false, then TMM command will show detailed mail information when the Invitation Monitor starts.
TEM: [Toggle Error Mode] All the MDS errors are directed to error.log file found in the log directory. When ever there are errors, the MDS maintains an error log to store the error string. If the TEM is on, the MDS will store the error message in the error log file as well as it will show the message in the MDS console.
RRS: Show the status of the response report feature.
RRSC: Change the response reports e-mailing. You can also change the e-mail address to which the reports are sent with this option.
6.3 Logfiles

The MDS uses Log files to record all events and errors with appropriate messages. It helps both the vendor and the customer to search and find the possible cause of errors with time and other necessary information. Also, all kind of activities performed by the user and the software are recorded in the log files.

In Windows, The MDS stores the log files in the installation folder under the directory named Log. In this directory, you will find error.txt and event.txt. You can open error.txt and event.txt using any text editor such as Notepad or WordPad.

In Linux, The MDS stores the log files in the directory /var/log/mds/. In this directory, you will find error.txt and event.txt. You can open error.txt and event.txt using any text editor such as vi or nedit.

All events and errors are recorded with the date, time and the function/process name. An example:

17-02-2002 01:47:20 PM :: CDialogueServer.initializeDatabase() Error at Server startup :: Your Database account information may not be correct. Please check it.

If you face any problem while using the MDS or the MPM, please look in these log files to see if you can fix the problem yourself. If you want to report a problem to Metatude Support (support@metatude.com), please include the logfiles.
6.4 Multiple Sites

With one instance of the MDS, it is possible to conduct surveys on multiple sites. Each site can be customized to the specific style of a company. When you install the MDS, you can enter the data for different sites. The following data is requested for a site:

- URL of the MCIC. You can customize the default stylesheet for the MCIC. To conduct surveys for different sites, simply install multiple MCIC's
- E-mail template. You can create HTML e-mail templates for each site. Each invitation or reminder e-mail that is sent out by the MDS, can make use of such a template.

A site consists of the combination of an optional e-mail template and a MCIC installation.

You can configure new sites or edit existing sites in the console window of the MDS. The following commands are available:

urll: Lists all sites registered to this MDS.
urla: Adds/registers a site to this MDS.
urle: Edits a site registered to this MDS.
urld: Deletes a site registered to this MDS.

To add or edit a site, enter the appropriate command and follow the instructions in the console.
6.5 E-mail Templates

You can customize the invitation and reminder e-mails to your corporate style. This is done through an e-mail template.

The e-mail template can be any HTML file. However, the MDS needs to know where in the template the invitation body should be merged. For this, it is required to specify a special tag named `<MyEmailBody>` within the template body. When the MDS finds this tag within the email template, it replaces this with the actual invitation/reminder created in MPM, just before sending out the emails. To add this tag in the email template, use the following steps:

- a. Open the HTML template file using any standard HTML editor
- b. Locate the position where you want the email body to be placed
- c. Type `<MyEmailBody>` (if you modify the HTML file using a text editor, you should use `&lt;MyEmailBody&gt;` instead of `<MyEmailBody>`).
- d. Save the file

Any image, clipart or other files required by the template should be placed on a web server which is accessible by the respondent.

You place the finished e-mail template in the Stationery directory, which is located in the home directory of the MDS. (usually C:\Program Files\Metatude\Metatude Dialogue Server\ on a Windows platform or /opt/mds on a Linux platform)
6.6 FAQ

Q: I get a database error, but I know the database is running.

A1: Please verify you entered all necessary data correctly. If not: remove the MDS preferences file and restart the MDS. You can now enter the data again. The preference file is called
preferences.dat and is located in the directory you installed the MDS in. Bear in mind that the
JDBC URL and driver names are case sensitive.

A2: Please check if you can connect to the database with other applications. For an ODBC
datasource, try using MS Access to connect to the database, for other databases, try using the
proprietary client side tools that came with the database. Please note that you need to be able to
connect using TCP/IP when using PostgreSQL, Oracle, IBM DB2, MS SQL Server or your own
JDBC driver, even if the database resides on the same machine as the MDS.

Q: I cannot connect to a MS SQL Server database

A: Make sure that you are using MS SQL Server authentication. Windows authentication will not
work.

Q: Are ther any free databases that I can use?

A: For Linux, use PostgreSQL. For Windows, use MSDE, the free version of MS SQL Server
database. MSDE has some limitations. If you plan to use the Metatude software at a large site,
please consider an alternative.

Q: I'm unable to connect to an Oracle database using the MPM

A: Please make sure the table name is in UPPERCASE.

Q: How can I avoid Virtual Memory Problem while running MDS?

A: This kind of problem may appear if there is less disk space that MDS uses as a virtual memory.
The MDS uses a maximum of 250 MB disk space for its virtual memory operations. So, if you have
less than ~250MB you may face a Low Virtual Memory problem. To avoid this problem you need
more than 300MB free disk space all the time while the MDS is running. More than 400MB free
disk space is recommended.

Q: How can I avoid "MDS is Halted" activity?

This may happen while you are running the MDS under the Windows platform and your console
window is in “Quick Edit Mode”. If your console window is in Quick Edit Mode and you click on the
window you will see a selected spot on the console screen. This kind of activity halts MDS
operations. You may get no response from the MDS even if you request it from the MPM. We call
this state “MDS is halted”. The same problem will occur if you select any area on the console
window using your mouse. The selected area will be highlighted. So, it is very easy to see whether
the MDS is halted or not.

To avoid this problem, just press "Esc" key on your keyboard and the MDS will be instantly
activated. And you should uncheck the Quick Edit Mode option from the command properties of
the console window to avoid unintentional "MDS is halted" activity.
Q: When installing the MDS I get the error "Database Initialization Error"

A: You are probably running the MDS on an older version of windows (NT). Some versions of Windows do not have the most recent database drivers installed. Please take the following steps to bring your system up to date:

1. Upgrade your Windows version to the latest service pack.
2. Install Internet Explorer 4.0 SP2 or higher (version 5.0 or above is preferred)
3. Install Microsoft Data Access Components (MDAC) 2.6 or higher. The most recent version can be downloaded from http://www.microsoft.com/data/download.htm
4. Install Jet 4.0 SP3 or higher. The most recent version can be downloaded from http://www.microsoft.com/data/download.htm#Jet4SP3info
5. Install the MDS.

Q: The MDS shows an SMTP error. What is wrong?

A: You may have this problem for 2 reasons.
- Given information about the location of the SMTP server may not correct
- SMTP server is down
Please check the information you provided for your SMTP server. if it is correct then check the SMTP server wether it is running or not.

Q: When requesting a dialogue I see an Internal server error instead of the requested dialogue

A1: You are using Microsoft IIS to serve dialogues. The default installation of IIS for Windows XP Professional SP1 and up causes this error. Please do not use IIS for Windows XP. Windows XP is not a server platform, its main use is for the desktop. You can use any other version of IIS, for example the version that is shipped with Windows 2000.

A2: You are using Apache / Tomcat to serve dialogues. There might be a configuration error or Tomcat is busy starting up. Please wait one minute and try again. If the error persists, then Apache cannot find Tomcat. Please check your mod_jk.log file to see what's wrong.

Q: When trying to submit a project in the Project Manager I get an error. Why?

A: An error could occur when you are submitting a large dialogue. This error probably arises because you are using an older version of PostgreSQL as the results database for the MDS. PostgreSQL 7.1.2 and up are able to handle large dialogues. To solve the problem, please upgrade PostgreSQL to the latest version.

Q: Directly after starting, the MDS hangs using Linux. Why?

A: Some Linux distributions come with a very new version of the 'glibc' libraries. Unfortunately, these are incompatible with the JRE (Java Runtime Environment) that the MDS uses. To fix this problem, try the folowing before starting the MDS:
Enter `export LD_ASSUME_KERNEL=2.2.5` in a terminal window. After that, start the MDS again. Please note that you will have to export this environment variable each time before starting the MDS.

Q: The MDS won’t install on Windows NT 4.0. How can this be fixed?

A: The MDS is compatible with Windows NT 4.0. Please set your colors to 256 or higher in your display preferences. The MDS won't install when 16 colors are used in Windows NT 4.0.
Q: I am getting submission error in the browser and MDS console and error log shows "maximum number of processes () exceeded".

A: Above error can be seen when MDS is running with Oracle 8i database and the number of respondents exceeds the number of default Oracle process. Oracle processes specifies the maximum number of operating system user processes that can simultaneously connect to an Oracle Server. This value should allow for all background processes such as Job Queue (SNP) and parallel execution processes. To increase the number of default Oracle process you have to change the Oracle initialization parameter.

To change the parameter value, open Oracle DBA Studio. Make sure you have 'SYSDBA' rights. Go to instance from the tree view and select Database. Now from the General tab open All Initialization Parameters. Now look for the processes from Parameter Name. Increase the value according to your need. Such action will prompt you to restart Oracle. You can also modify the value of processes directly from the init.ora file.

Q: After submitting a dialogue, the error 'Unknown Error' is shown when PostgreSQL is used as the results database

A: You may see this error if the submission rate is higher than the maximum number of allowed connections at a time by the PostgreSQL database. PostgreSQL has a configuration file postgresql.conf in the /var/lib/pgsql/data directory. Configure the max connection limit according to your need to avoid such an error.

Q: Why is the LDAP stakeholders count not displayed correctly?

A: You will see the correct LDAP stakeholders count if the LDAP server contains less than 5500 stakeholders. In the following cases, the stakeholder count may be displayed incorrectly:
1. If you are connecting to a LDAP server with a size of more than 5500 stakeholders.
2. If the server stakeholder size limit is set to less than the actual number of stakeholders the server holds.
6.7 Unicode issues

Q: How do I check the encoding that the MDS uses?

A1: Type createmdsinfo at the console. A file called MDS_Information.txt will be created in /tmp on Linux systems and in the home directory of the MDS on Windows systems. This file includes the encoding.

A2: See the information in the event.txt logfile.

A3: Watch the output as you start the MDS.

Q: I am facing problems when reading Unicode characters in my browser! What are the possible reasons for this?

If you are unable to read some Unicode characters in your browser, it may be because your system is not properly configured. Here are some basic instructions for doing that. There are two basic steps:

a) Install fonts that cover the characters you need
b) Configure your browser to use them.

Fonts

Note:
Ideally, you will install fonts that are tuned for the scripts that you particularly need, then also install a full Unicode font as a backup. The following describes how to get fonts for different platforms.
You can also find other fonts at Useful Resources.

Windows

For Windows 2000, getting additional languages installed can be done as follows: Choose Start > Settings > Control Panel > Regional Options. In the General tab, set all the languages you may want to display, the more your set, the more you will be able to process multilingual data through all your applications, including your browser. This adds fonts as well as system support for these languages.

Tuned fonts: Go to Start > Settings > Control Panel > Add/Remove Programs > Windows Setup > Components > Multilanguage Support > Details and check the languages you want. Also useful is to go to http://windowsupdate.microsoft.com and install the Explorer language packs, which add the fonts to your system.

Full fonts: If you have Microsoft Office 2000, you can get the Arial Unicode MS font, which is the most complete. To get it, insert the Office CD, and do a custom install. Choose Add or Remove Features. Click the (+) next to Office Tools, then International Support, then the Universal Font icon, and choose the installation option you want.

Unix/Linux

A range of quite comprehensive fixed-width Unicode on-screen pixel fonts for X11/Unix users can be downloaded from http://www.cl.cam.ac.uk/~mgk25/ucs-fonts.html or directly as http://www.cl.cam.ac.uk/~mgk25/download/ucs-fonts.tar.gz
Check the included README file for detailed installation instructions.

An earlier version of these fonts is already automatically installed when you use the XFree86 4.0 X server, which is the one commonly used under Linux.
The Mozilla, Firefox and Netscape 6 web browsers can make use of these fonts directly and are highly recommended for anyone interested in utilizing Unicode web pages (make sure to use the very latest version though). Just select the "-misc-fixed-iso10646-1" font for the "Unicode" category in the "Edit|Preferences|Fonts" setup menu. The Netscape 4.x browsers cannot handle 16-bit Unicode fonts at all. However, the above package contains scripts to generate 8-bit fonts in all ISO 8859 variants, which Netscape 4.x will then use to display those Unicode characters that are also found in ISO 8859.

**Browsers**

You should make sure that you are using the most recent version of whatever browser you use, and have installed the fonts you want. The following then describes how to configure browsers for different fonts.

**Internet Explorer**

IE is fairly smart about picking tuned fonts for different characters. To set your font as the default for a given block of characters, choose Tools > Internet Options > Fonts, then select the fonts.

Monospace Fonts: IE uses Web page font to mean variable-width, and Plain text font to mean fixed width. Unfortunately, IE will not let you pick a variable-width font in the Plain text font box. That means in practice that you simply can't view most Unicode characters in fixed-width.

**Netscape Navigator**

You will need to tell NN which fonts to use for which encodings. To set your font as the default for a given block of characters, choose Edit > Preferences > Fonts. Then for each encoding you are likely to use, pick the appropriate fonts for the Variable Width and Fixed Width fonts. It is particularly important to set default fonts for Unicode. These fonts will be used when NN encounters documents encoded in a Unicode variant.

Monospace Fonts: NN lets you select any font for fixed-width content. This allows you to use a variable-width font in the Fixed Width box. While you lose the alignment of the characters, at least you can read the content.

**Further Information**

The following link from Alan Wood's Unicode Resources also offers helpful information on specific topics.

For setting up browsers on different operating systems for Multilingual and Unicode Support:
http://www.alanwood.net/unicode/browsers.html

**Q: Which browsers support UTF-8?**

Please read your browsers support manual to find out whether it supports UTF-8 encoding or not.

**Q: My browser still doesn't show any Unicode characters, what is wrong?**

If you followed the steps as described in the answer of the previous questions and still can't see Unicode characters properly then you have to set the encoding of the browser. The following describes how to configure browsers for UTF-8 encoding.

**Encoding setting in Internet Explorer:**
Here the encoding setting procedure for Internet Explorer 5.00.3700.1000 is given. For another version if this procedure doesn't work then please read the documentation for that version.

Open IE → Go to View menu → Go to encoding → Select Unicode (UTF-8)
Encoding setting in Netscape Navigator:
Here the encoding setting procedure for Netscape Navigator 6/6.01 is given. For another version if this procedure doesn't work then please read the documentation for that version.

- Open Netscape Navigator
- Go to Edit menu
- Go to Preference
- In the Preference window you will find Category list at the left side of the window. From this list expand Navigator category and select Language.
- In the right side of the Preference window you will get the properties of selected language. Then at the bottom you will get Character Encoding selection option.
- Select Unicode (UTF-8) as character encode.

Q: How to configure Outlook express to show utf-8 encoded data?
If your Unicode characters do not show properly in Outlook Express, try the following settings:
- Go to Tools and select Options from the menu.
- Click on 'Read' tab
- Then click Fonts button
- Select Unicode from the font settings list, Arial Unicode MS from proportional font, and Unicode (UTF-8) from encoding drop down menu.
6.8 DB2 configuration

DB2 configuration for MDS:

We have tested the MDS with Windows 2000 IBM DB2 Universal Database Version 8.1. If you use DB2 for your MDS database, you may face some problems while working with large dialogues. To avoid these problems please configure your DB2 as described below.

Configuration of DB2 database for large dialogues:

In order to store big dialogues, a table with a row width greater than 8k, more than 500 columns needs to be created in DB2. You will then need a buffer pool greater than 4k. To create a buffer pool and a tablespace each with 16k page size, run the following in the command center of DB2 interfaces:

```
CREATE BUFFERPOOL highmem SIZE 32 PAGESIZE 16K
CREATE TABLESPACE mds_tbsp PAGESIZE 16K MANAGED BY SYSTEM USING ('D:\DB2\MDSTABLESPACE') BUFFERPOOL highmem
```

Now, add this tablespace to the user as follows:

Open DB2 Control Center, Explore database, Go to Users & Groups, Rightclick on username, Select Change users, Go to tablespace tab and add required tablespace.
6.9 PostgreSQL

Postgresql supports the full range of locales and charactersets. It can even use the UTF-8 (Unicode) characterset. Postgresql result databases and stakeholder databases (directory servers in the MPM) need to be created for use with the ISO-8859-1 or UTF-8 characterset.

To create a database in Postgresql that uses the ISO-8859-1 characterset type
createdb dbname -E 'LATIN1'
at the commandline, or type
create database dbname with encoding = 'LATIN1';
at the psql client, where dbname is the name of the database.

For UTF-8 encoding enter
createdb dbname -E 'UNICODE'
at the commandline, or type
create database dbname with encoding = 'UNICODE';
at the psql client, where dbname is the name of the database.

To check the encoding of the databases type psql -l at the commandline. It is also possible to configure Postgresql to use the ISO-8859-1 or UTF-8 characterset by default. Please see http://www.postgresql.org/idocs/index.php?multibyte.html for more information on the subject.
6.10 LDAP

You can connect to a big LDAP directory server using the MDS. When the MDS connects to a big LDAP server it increases the amount of used memory, which may crash the MDS depending upon the system you are using. To avoid this situation the default stakeholder size limit the MDS can connect to and count is set to 5500. You can change this depending on your needs.

Changing the maximum amount of connected stakeholders through LDAP

You can see the LDAP stakeholder size limit from the MDS console command line with the command `ldap`. To change the size, enter the command `ldapc` in the console. You will then be requested to enter the maximum number of stakeholders that can be connected through LDAP. If you want to connect more than 50,000 stakeholders, enter `-1` as the new size. This will result in an unlimited number of stakeholders that can be connected.

Please make sure that you have enough memory available if you want to connect many stakeholders. The MDS uses approximately 20 MB per 10,000 extra stakeholders that are connected. The amount of extra memory that is needed varies per directory server.

You can not decrease the size limit if you already created one or more LDAP directory servers with the MPM that have more stakeholders. You have to delete the existing LDAP directory server before decreasing the LDAP stakeholder size limit.
6.11 Memory

If the MDS runs out of memory, it will place an error in the logfile and exit. Under normal circumstances, this shouldn't happen. If this error occurs frequently, then you can change the maximum amount of memory that the MDS uses. To be able to do this, you need enough physical memory in your computer. For an installation of the MDS that is used intensively, Metatude recommends at least 1 GB of memory.

Changing the maximum amount of used memory
Enter the command `vm` in the console to see the maximum amount of memory that the MDS will use. Enter the command `vmc` to change these settings. The changes you enter here will be placed in a config file and are permanent.
Index

- A -
  about 3
  access 28

- C -
  characterset 35
  charmap 35
  command line 23
  configuration 12

- D -
  database connection 12
  db2 34
  debug 23

- E -
  errorlog 25
  eventlog 25
  exit 23

- F -
  FAQ 28
  foreign languages 35
  freeze 28

- H -
  hang 28

- I -
  installation 10
  ISO-8859-1 35

- J -
  jdbc 12

- L -
  large dialogues 34
  ldap 36
  license key 12
  linux 10, 28
  logfiles 25

- M -
  memory 28, 37
  metatude 2

- O -
  odbc 12
  oracle 28

- P -
  postgresql 28, 35
  preferences 16

- R -
  response report 22

- S -
  service 17
  smtp server 12, 28
  stakeholder count 36
  startup 11, 17

- V -
  virtual memory 37

- W -
  webserver 12
  windows 10, 17, 28

© 2001 - 2004 Metatude